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English MineSimU Tutorial

The MineSimU module of ICAMPS does underground mine planning. This module provides timing maps,
production forecasts and related information for budgeting, evaluating mine plans and equipment acquisitions. Each
ICAMPS module runs inside AutoCAD and combines standard AutoCAD commands with special ICAMPS
commands which are unique to mine planning. Each ICAMPS header menu has five pulldowns for the most
commonly used standard AutoCAD commands; three on the left labeled Tools, Edit and Display and two on the far
right labeled Draw and File. The center pulldowns access special ICAMPS functions. In the MineSimU module,
these pulldowns are labeled Setup, Layout, Simulate and Output as shown below.
Developing a mine plan and generating maps, reports and other budgetary data require the following inputs: A
gridded seam model for geological data, a calendar of working days and shifts, a mine layout, a file of machine
characteristics and the sequence in which areas will mined. These inputs are generated in the following steps. To
begin the tutorial you must open a drawing. Use the drawing TUTORIAL.DWG which is in the directory
X:\applied\datadir where X is the drive where you have loaded the MineSimU software.

1. Creating a Grid

The recommended first step is to create an ICAMPS grid. Grids for individual seam parameters (hereafter called Z-
files) are combined into a master grid which contains up to fourteen parameters. MineSimU will accept Z-files from
many different geological modelling systems. For this example, we will create a grid called NEWGRID and add
seam height information from a Z-file called SEAMHT.ENZ. First select the Setup option from the header menu as
shown below.

Next select the MineGrid Module option which will bring up the following menu.
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Click the Create a Grid File option from the pulldown menu.

A dialog box for entering the file name and path will appear. Type X:\applied\datadir\Newgrid in the edit box.
After entering the file information, click the OK button. The Model for Grid Extents dialog box will appear as
shown below.

Notice that the Grid Extents and other data are grayed out and full of -99's. To create the master grid file, you must
first input this information. MineSimU extracts this data from a Z-file you specify. Normally this file will come from
the first Z-parameter you insert into the master grid. You must specify the type of Z-file. Click the down arrow next
to the word TYPE: to display the file type formats which MineSimU will accept. The file SEAMHT.ENZ is in the
ENZ format. Most systems will export an ENZ file format (Easting,Northing and Z value for each grid node). But,
CPS and Surfcadd (Scad) only export in their own format. QSB formats are optional Z-file exporting options in
MineSurf.

Select ENZ as the file type and click the Retrieve Extents button. The following dialog box will appear. Type the
file name and path, X:\applied\datadir\SEAMHT.ENZ or click the Browse button and search through the
directories to find this file.

After you designate the file, click the OK button and you will return to the previous dialog box but now the grid
extents (maximum and minimum x and y values in the grid), grid increment size and number of blocks in the X and
Y direction will be highlighted and filled with the new values.

Now you can enter data into the master grid. Click the box next to the word ELEVATION on the upper right and
select the parameter Seam Height. Clicking the OK button will save this information and bring up a dialog box as
shown in the following example.
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To add other Z parametr data to the master grid file NEWGRID, highlight the parameter in the list of parameters
and click the Add/Change button. The following dialog box will appear with the Z parameter name at the top.

If you had other Z-parameter files you could add them to the master grid at this time. The source of the grid data will
default to Z File. You must specify the Type of file format and type the path and name for the Z-parameter file or
browse for the file name and path. Then click the OK button. The preceding dialog box will reappear with today's
date next to parameter you added to the master grid file.

We will now enter the default values for missing grid node values. Click the Edit Default Parameter Values button.
The following dialog box will appear.

Use the edit boxes on the right to change the default values. Type 85 for the density of coal and 125 for the out of
seam density and then click the OK button. The previous dialog box will appear. For now click the Save button to
save your inputs in the ICAMPS grid file and exit the grid creation process. There will be a short pause while the Z
parameter values are loaded into the ICAMPS grid file. Hit the Enter key to return to the MineGrid Module menu.
All the other MineGrid Module menu options can be ignored at this time.

2. Set defaults
You normally need to enter default values once per mine. Select the Setup header. Click the first option in the menu,
Configure MineSimU. The following dialog box will appear.
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Select the Simulation Defaults option. The following dialog box will appear. You can accept all the defaults, but
you should input 20 as the entry width to match the example in the tutorial. Likewise the defaults on the right are
usually acceptable. Normally you would replace any of the defaults with the values you most commonly use. For the
english version of MineSimU, you must also indicate whether your seam height is in feet or inches. The metric
version assumes all seam heights are in meters. Click the Inches box for this example and then OK to leave this
option.

Next select the Boundary and Text Size option to bring up the following dialog box.
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The boundary should span the maximum extend of your mine layout. For this example type 3000 and 2200 for the
minimum X and Y respectively and 18200 and 13400 for the maximum X and Y respectively. Accept the existing
defaults for the other parameters. They can be changed later as needed. Click OK to return to the Configure
MineSimU dialog box.

When you develop a mine plan in MineSimU, you must assign calendars to machines and master grids to mining
areas. Instead of typing long paths and file names each time a calendar or grid is specified, each calendar is assigned
a unique number from 1 to 20 and each master grid is numbered from 1 to 20. When you need to specify a calendar
or grid, you merely type its reference number. These numbers are assigned in the Calendar and Grid Files option.
When you select this option, the following dialog box appears.

The dialog box comes up defaulted to calendar 1. Type the path X:\applied\datadir and the name NewcalHD. If the
calendar already existed, you could use the browse button to search for this file. The calendar file can be empty at
this point. You must create at least one calendar and we will use only one in this example. Your own application may
require several calendars if your machines work on different schedules.

You must also specify at least one ICAMPS grid file. The dialog box comes up defaulted to grid 1. For this example
we will use the grid Newgrid.grd in the directory X:\applied\datadir. Click the Browse button to search for the
desired grid file. Additional grids are not required in this case, but you have the option to specify up to 20 grids in
one mine drawing.

The other options in Configure MineSimU dialog box, Difficulty Code and Height Sensitive Mining can be
omitted for the time being.

3. Layout/define mining areas
The next step is to draw the mine layout. Each mining area is drawn as a four sided closed polygon which represents
the rib to rib outline of the area. There are two methods for drawing mining areas, one is to pick the corners using the
cursor and is most useful if you already have an AutoCAD drawing of the mine layout. The other, called mining area
by two points, is most useful if you are drawing on a blank screen or are adding mining areas to an existing layout
and the area to be drawn are regular parallelograms. To start the layout, select the Layout pulldown menu as shown
below.



6

We will use the Mining Area by Two Points method to draw the small mine shown below which consists of a set of
mains, three longwall panels and the required longwall gates and startup rooms.

Assume the mains have five entries on 80 feet centers and the entry are 20 feet wide. The rib to rib width will be 340
feet. The mains start 500 feet before the first longwall gate. Each gate has three entries on 60 centers with 20 feet
wide entries for a total width of 140 feet. Each longwall panel is 500 feet wide and 5000 feet long. Start at the
coordinate 13750, 5950 and draw the right side of the mains. The total length of the mains is 500 feet plus the width
of four 140 feet wide gates and three 500 feet longwalls for a total length of 2560 feet. The gates are 5340 feet long
(5000 feet for the longwall panel plus 200 feet for a barrier pillar and 140 feet for the startup room).

Be sure you have the Osnap function turned OFF before you begin. Select the LAYOUT pulldown menu and
choose the Mining Areas by Two Points option. A series of command line prompts will appear. Type your
response to each prompt and then press Enter (<R>). The first command line prompt will ask for the first point:

Pick center of starting side/<R> to end

Type 13750,5950. The cursor will now be at the location13750, 5950 and the command line will ask for the second
point:

Pick center of ending side:

Type @2560<270. The next command line prompt will ask:

Azimuth/Perpendicular/Pick Orientation

You want the mains to be rectangular, so type P for perpendicular. The next prompt will ask:

Enter Perpendicular Width Left of First Side:

The ICAMPS convention is to assume you are looking from the first point to the second point. Since the points you
placed coincide with the right side of the mains, type 340 as the distance to the left side. The next prompt asks:
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Enter Perpendicular Width Right of First Side

Enter 0.

The mining area will now appear as a four sided polyline with the long axis north - south. Next you are asked to
place the label for the polyline.

Pick point to start label:

Pick a point inside the polyline near the center. The next prompt asks you to pick a point to orient the label on the
drawing:

Pick Alignment point:

Pick a point so that the label is aligned with the long axis of the polyline. The label N000 and an attribute block
should now appear inside the mining area.
Now use the mining area by two points method to draw the other mining areas. To make a neat, accurate drawing,
select the appropriate SNAP function from the Tools pulldown to pick a point on the existing drawing. For example,
to draw the first gate with the center of the starting side at 500 feet below the upper right corner of the mains, at the
prompt, type 13750,5450. To make the gate horizonal, extending off to the left and 5340 feet long, in response to the
Pick the center of the ending side prompt, type @5340<180. Now type P for perpendicular and make the area
width to the left 140 feet and zero feet to the right. Respond to the label orientation prompts to make a horizontal
label near the center of the gate. The mining area for the gate will now appear as shown below.

Now draw the mining area for the start up room. Again use the Mining Area by Two points method to draw the
area. Select the Intersection snap mode from the Tools pull down menu. Now pick the lower left corner of the first
gate you drew as the center of the starting side. Since the long wall panels are 500 feet wide, the center of the ending
side will be at 500 below the starting side. Type @500<270 in response to the prompt for the center of the ending
side, then P for perpendicular, and 140 for the area width to the left and 0 feet as the width to the right. Again pick
the label in the middle of the area and oriented horizontally to the right.

Next draw the first longwall panel using the two point method.Use the Intersection snap mode to pick the upper
right corner of the start up gate as the center of the starting side and the lower right corner as the center of the ending
side. Make the width to the left 5000 and 0 to the right. The mining area for the longwall panel will end 200 short of
the mains. This space will be a barrier pillar.

You have drawn mining areas but in order to schedule the mining, each mining area must be Defined. A defined area
is designated as either a development, bleeder or longwall, given a number, name and associated with specific
scheduling information.To define the mining areas you have drawn, select the Layout pulldown menu and choose
the option Define New Areas. The following dialog box will appear.
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For every mining area you must enter the Area type, Name, Seam and Grid number and the direction of mining. If
the area is a development or bleeder, you must also specify the entry width and percent extraction.

Fill in the edit boxes below the List box. Start with the area we called the Mains. Select Development for the type,
an identification (ID) number is automatically assigned. The edit boxes for Entry Width, and % Extraction, Seam
and Grid automatically default to the values you specified in the Configure MineSimU setup procedure. Accept the
defaults for now and type a name, such as East Mains. Next click on the button labeled Pick, The following
command line prompt will appear:

Pick attribute block of area to be defined/<R> to end:

Now pick the attribute block for the mining area we referred to as the mains when you drew the mining area.

After you pick the attribute block the following prompt appears:

Is Correct area highlighted (Yes,No)/<Yes>:

The mains area should now be highlighted. Press the Enter key to take the "Yes" default.

The mining area will now be shown with each vertex numbered and green arrows will point inward from the middle
of each side of the mining area. The following command line prompt will appear:

Pick direction of mining/<R> to end:

Pick the arrow on the North side of the area because you want to mine in the North to South direction. After you pick
the direction of mining, the area's type abbreviation and ID number will appear in the list box along with the other
information you entered.

Now repeat the above process for the gate. Give this area the name Gate1, accept the defaults, pick the attribute box
for the mining area at the top of the screen and choose the East to West mining direction arrow.

Do the longwall panel the same way. Name it Longwall1. You will notice the entry width and percent extraction are
grayed out and default to 0.00 feet and 100 percent respectively. Accept the defaults, pick the attribute box for the
longwall mining area and select the West to East mining direction.

You will notice that the Define New Areas dialog box also has a Draw button. This button lets you draw mining
areas at the same time as you are defining them. That is, instead of picking the attribute box of a previously drawn
mining area, you select the drawing method, by four points or two points, and click the Draw button. You then
follow the same procedure as described above for drawing mining areas.

We took the defaults for the entry width and % Extraction. Let us enter the theoretically exact values for the East
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Main mining area. The entry width and spacing were given above. Highlight the line for East Mains area in the list
box and click the Calc. % Extract... Button. The Calculate Extraction dialog box will appear as shown below.

If you have not used this option previously, the list box will be empty. To calculate the percent extraction for the
East Mains area, click the New button. A icon screen of Pillar Configurations will appear as shown below.

Assume the pillars have a uniform rectangular pattern. Click the icon in the upper left hand corner of the dialog box.
The following command line prompts will appear:

Calculation Adjust. is NORMAL/MinerBorer/RoadHeader (N/M/R) <N>:

Accept the Normal default which applies to Entries having a rectangular cross section such as cut with a continuous
miner.

Number of entries:

Type 5

Specify entry spacing individually/ (Yes,No) <No>:

Take the No default.

Center-to-Center distance of Abutment entries:

Type 80

Specify entry widths individually/ (Yes,No) <NO>:
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Take the No default.

Entry Width:

Type 20

Center-to-Center distance of Abutment Pillar crosscuts:

Type 100

Crosscut Width:

Type 20

After you enter the cross-cut width, the calculated percent extraction and mining area width appear in the command
line.

Percent extraction: 43.529
Keep Configuration (Yes/No) <Y>:

Take the Y option and the next command line prompt will ask:

Enter Name of this configuration <NoName>
Type a name which will help you identify the configuration in the future such as 5E80X100 for the name. The new
configuration will appear at the bottom of the list. To assign the calculated percent extraction to the defined mining
area we called East Mains, highlight the new configuration line in the list box and click the OK button.

You are now returned to the Define New Areas dialog box. The percent extraction in the edit box will now be 43.53.
Click the Change button to replace the previous value for percent extraction in the list box.

Highlight the line for Gate1 and repeat the above steps to calculate the theoretical percent extraction. Assume both
the gate and startup room will have uniform rectangular pillars on 60 by 80 feet centers and the entry and cross-cut
widths are 20 feet. Name this calculation 3E60X80. The calculated percent extraction of 57.14 will appear in the edit
box. Click the Change button to insert this value into the percent extraction for Gate2. Now highlight the line for the
Startup1 room, click the Calculate % extraction and select the line named 3E60X80 and click OK. The calculated
value of 57.14 will now appear in the percent extraction edit box. Click the Change button to update the percent
extraction for Startup1.

The information in the list box is not saved permanently with the drawing until you click the SAVE button. Click the
SAVE button; the defined mining areas information will be saved in a file called Area Definition and the mining
area ID numbers will now replace the N000 labels in the drawing.

Now expand the mine layout by adding additional gates, start up rooms and longwall panels. Use the Mining Areas
by Two Points method to draw the second and third set of gates, startups and longwalls. Increment each name by 1,
For example the second gate will be Gate2 and the third will be Gate3 etc. You may want to use the Define New
Areas method to draw and define the areas in one procedure.

When a layout consists of a repeating pattern, the easiest procedure is to copy the previously defined areas.
MineSimU has a copy function in the Mining Area Utilities options under the Layout pulldown. Try this feature to
draw the fourth gate. Click the Mining Area Utilities option to display the following menu.



11

Select the Copy Areas option from the list.

Caution: Do not use the standard AutoCAD COPY command to copy mining areas!

When you save a defined area, the area identifier and scheduling information for each area are written in the Area
Definition file. The ICAMPS COPY command automatically draws the copied areas polylines, attaches an attribute
block, assigns a unique ID number to the new area, transfers the static information from the copied attribute block,
and asks for information that is unique and user dependent, i.e. the area name, and updates the Area definition file
with a record for each new area or subarea. The AutoCAD COPY command simply duplicates the information in the
drawing. AutoCAD does not assign a unique ID number to a copied area, will not ask for the area name and does not
update the area definition file. Consequently areas copied with the AutoCAD copy command cannot be
scheduled.

When you select the Copy Areas option, the following command line prompts appear.

Surround attribute blocks of areas to be copied(4 point polygon):

The enclosing polyline can be of any shape or size. Window around the attribute block for Gate1. Only areas with
attribute blocks completely inside the window will be copied.

Pick first corner:
Pick second corner:
Pick third corner:
Pick fourth corner:

After you create the window you are asked to specify how to displace the selected areas.

Displace by (Point/Feet/Quit) <Q>:

Type P to select the point method.

Use the Intersection snap mode to select the upper left hand corner of Gate1 as the base point. The next prompt asks
for the magnitude of the displacement of the base point.

MAGNITUDE <XXXX>:

XXXX is the distance from the base point to the current position of the cursor. Pick the lower left hand corner of
Startup3 as the displacement point.

The copied areas will now appear, one at a time. The copied area's ID's will appear on the command line with a
default to the next available number. You can take the default or assign another ID number. Next the command line
prompt will ask for area name. Name the new gate Gate4. After you enter the name, the area attribute block and ID
label appear on the drawing. If you were copying several areas, the process would repeat for each copied area.

Although you have defined the mining areas, you may not want to mine them as one continuous area. Rather, you
probably will advance the mains until you pass a gate, stop, stub off the gate to allow for construction work, and then
continue to mine the mains until you pass the next gate. Therefore, to assign work to the mining machines, you
should divide the large mining areas into two or more sub-areas according to how they will be mined. You will then
assign these sub-areas to machines.
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The function to divide mining areas is in the Edit Mining Area File option under the Simulate pulldown menu as
shown below.

When you select the Edit Mining Areas option, a dialog box will appear as shown in the following example.

Each mining area you have defined will appear in the list. To sub-divide the Mains, highlight its line and click the
divide button. The screen will automatically zoom to the Mains area and the numbers 1 and 2 will appear at each
corner of the end where you specified the mining to begin. The following command line prompt will ask you to
select the side to sub-divide.

Enter side to use (1,2): <1>:

You are asked to select a side to subdivide, because a mining area can have an odd shape, and one side may be more
suitable as a reference for sub-dividing the area. In this case select the side adjacent to the gates because you will
want to divide the area relative to where the gate begin.

After you select the side the following prompt appears:

Enter length (or pick point) of subarea 1/ [0] to exit <YYYY>:

YYYY is the total length of the Mains.

In most cases the sub-division points are not critical and you can select the points visually. Where the sub-divisions
are more critical, type the exact distance to the point where you want to subdivide. For this application use the cursor
to pick the point for the first subdivision. A white rubber banding line will appear that starts at the selected corner.
Estimate a point a couple of breaks past Gate1. The prompt will repeat but YYYY changes to the length of the
remaining undivided section of the area. As above, pick points beyond Gate2 and Gate3 and press Enter to
complete the sub-dividing.

Next divide Gates 1,2 and 3 into two parts. Highlight Gate1, select either side 1 or 2 and pick a point to create a stub
about two breaks long and press Enter to leave the remaining distance as one long sub-area. Repeat the process for
Gate2 and Gate3.
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To check your work, select the View mining areas option under the Simulate pulldown menu. After you select this
option, the following command line prompt will appear.

Area definition file display (Show/Draw/Quit) <Q>:

Enter S for the Show option. The areas with their sub-divisions should appear as shown below. The arrows indicate
the direction of mining for each area and/or sub-area.

4. Create working days calendar
Next you must create at least one working days calendar. Select the Edit Calendar File option from the pulldown
menu under the Simulate option. The following dialog box will appear.

The dialog box contains the calendar file you named in the Configure MineSimU option under Setup pulldown.
Click OK and a wall calendar for the first month of the first year will appear in the next dialog box as shown in the
following example. You can pull up the wall calendar display for any month of any year by highlighting the desired
month and year in the Month-Year list on the upper left. A check mark in the small box in each day indicates non-
working days.
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First turn off the non-working days that are common to each month, such as Saturday and/or Sunday, use the
Advanced option at the bottom of the dialog box. The following dialog box will appear. Click the circles under
OFF for Saturday and Sunday and under WORK for the other days of the week. If you want your mine to work only
four days per week, make a weekday an OFF day. The Shift/Day column will contain -1's which indicate to use
default values. You can either key in the values for each day or accept the defaults. If you are editing an existing
calendar, the Shifts/Day will default to the prior existing values in the calendar. If you are creating a new calendar,
the Shifts/Day will be the Shifts/Day you specified in the Simulation Defaults option under Setup. Then key in the
Starting and Ending months and years for the calendar. For this example make the Starting Month and Year 1
and 2000 and the Ending Month and Year 12 and 2007. Then click the Update button.

Holidays and vacation schedules tend to vary among mining companies, countries and years so that an automatic
procedure to indicate holidays and vacation days for every month of every year for every application would not be
appropriate. To indicate such OFF days, go to the desired month and year and click the small box in the square for
the day. Indicating holidays and vacation days will take only a few minutes and the process will rarely be repeated
because calendars, once created, seldom change.

If necessary, you can indicate the reason for the non-standard non-working days. If you highlight the word Holiday
before you click off the days, an H appears in each day you click off. Similarly a V appears in each day you click off
if you highlight the word Vacation before you click off the days. This information appears in some forms of the
scheduling Output.

The number of working and non-working days in each month appears in the dialog box for the month. To see a table
of working days for every month of every year and the total working days for each year, click the Work Days button
in any month's display. The list looks as follows.
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5. Specify machine parameters
The final input to the scheduling process requires certain technical information about each mining machine and a list
of mining areas assigned to each machine. This information is stored in the Machine Sequence file. To create this
file, select the Edit Machine Sequence W/Draw option under the Simulate pulldown menu. The drawing will now
show the mining areas including all the subareas color coded by area type and the following dialog box will appear.

Before mining areas can be assigned to a machine, you must define the machine. The dialog box initially comes up
with the machine information area grayed out. To define a machine, click the ADD button on the lower left side of
the dialog box. A dialog box as shown in the following example will appear superimposed on the previous dialog
box.

Enter the machine number, up to four digits long, in the Machine Number edit box. Then type the machine name,
such as Joy CM12, in the Text edit box. Now select a calendar for the machine. Previously you assigned numbers to
each calendar file named in the Calendar/Grid Files option within the Configure MineSimU option under the
Setup pulldown menu. Type the calendar number or select the calendar from the pull down list. In this example you
have created only one calendar file, therefore assign calendar number 1 to the machine.
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In the process of assigning mining areas to machines, the previously assigned areas will be colored to indicate which
machine will mine the each area. You must assign a color to the machine and also indicate how mining production
will be measured. The production options are raw tonnage per shift, clean tonnage per shift and advance per shift.

For this example, type 1 for the machine number, name it Joy Miner, assign calendar 1 to the machine and make its
color Green and use Raw tonnage per shift as the measure of machine production. Click the OK button to accept
your responses. The dialog box will disappear and now you must enter certain quantitative information for the
machine. Enter 500 as the raw tonnage production rate per shift, make the maximum mining height 12 feet, the
minimum mining height 3 feet and set the machine available date to the first work day of July, 2000, i.e. day 1,
month 7 and year 2000.

6. Assign Mining Areas to Machines
You must now assign mining areas to machines in the order they will be mined. Highlight the top line of the list box
on the right and the select the Super button. The dialog box will disappear, and following messages appear in the
command lines.

Please wait while drawing areas...
Indicating Assigned Areas...
Starting Super Pick process (CANCEL or RETURN to End)...
Pick a point inside the AREA to ADD <#X on List>:

The previously assigned mining areas will contain diagonal lines in the color of the machine to which they have been
assigned. In this example none should have been previously assigned.
Move the cursor inside the first area you want this machine to mine and click the left hand button. The following
message appears on the command line.

... ZZZ Added to the mining unit!

where ZZZ is the area ID number. The Pick prompt reappears.

The selected area will appear in green with diagonal lines crossing through the area to indicate it has already been
assigned to an area. You repeat the process until you either run out of areas to mine or you click the Enter button to
stop the procedure. The dialog box will reappear with the following message in the lower left corner.

[Y] Areas Added...

Where Y is the number of areas added to the list of mining areas assigned to this machine.

For this example, assign areas in the following order:

subdivision 1 of the Mains. D1-1
subdivision 1 of Gate1. D2-1
subdivision 2 of the Mains . D1-2
subdivision 1 of Gate2. D4-1
subdivision 3 of the Mains. D1-3
subdivision 1 of Gate 3. D6-1
subdivision 4 of the Mains D1-4
the entire Gate 4 area. D8

Now repeat the above procedure to create a second Continuous miner. Make it the number 2 machine, call it Joy
12B, use cyan for its color. All the other options can be the same as for the first continuous miner. Assign mining
areas to this machine in the following order:

subdivision 2 of Gate 1 D2-2
the entire Startup Room 1 D3
subdivision 2 of Gate 2 D4-2
the entire Startup room 2 D5
subdivision 2 of Gate 3 D6-2
the entire Startup room 3 D7
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This machine must wait for continuous miner 1 to complete the stubs of the gates. You must edit the list of mining
areas assign to Continuous miner 2 to indicate these requirements. They are called precedence or P-Areas. Highlight
the line for subdivision 2 of Gate1 (D2-2) and click the pick button under P-Area1. The dialog box will disappear.
Pick a point in subdivision 1 of Gate1 and click the right mouse button. The ID D2-1 will appear in the edit box
under P-Area1. Click the Change button to insert the precedence area in the line for D2-2. Repeat the process for the
areas D4-2 and D6-2, which require precedence areas D4-1 and D6-1 respectively.

Next create a long wall mining machine. Make it machine 3, call it Longwall and assign magenta as its color. Use
the same calendar as for the continuous miners. Make the production rate 4000 tons per shift, Maximum mining
height 8 feet, minimum mining height 5 feet and the start date the first working day of January, 2001.

Assign the longwall areas to this machine in the sequence Longwall1, Longwall2 and Longwall3. After assigning the
longwall areas, highlight Longwall1 (L1) and pick area D5 as the precedence area. Longwall moves normally require
a significant amount of time between finishing one panel and beginning the next. The scheduling system allows for
this time. The column labelled OD, which stands for Offset Days, contain the number of working days allowed for a
longwall move. Highlight the line for L1 and type 15 in the edit box below the column labelled OD and click the
Change button. 15 offset days will now appear in the line for L1. We will ignore the column headed DMR for the
time being.

Repeat the process of adding precedence areas and offset days for the other two longwall panels. Pick areas D7 and
D9 as the precedence areas for Longwalls 2 and 3 (L2 and L3) respectively and assign 15 working days (offset days}
to each for the longwall move.

If you need to move from one miner unit to another, click the Next or Previous buttons. The system should now
have the information to schedule the mine. Click the OK button and select the Save option.

7. Calculate Timing and Display Results
To calculate the timing, click the Output pulldown; the following menu will appear.

and select the Calculate Timing option from the pulldown menu. The following dialog box will appear.
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Click the Check Precedences option, the Complete time period and press OK. A scheduling progress status report
will now appear while the system calculates the timing. It includes a list of mining areas, their status and the dates for
the current work. The Done button becomes highlighted when scheduling is complete. Click the DONE button.

Now select the Quick View Timing option to display the timing map. The dialog box shown below will appear.
Select View by: Month, Pause Every: Year and type the Time Period: Start Month: 1 of Year: 2000 and End
Month: 12 of Year: 2002. Use the Normal Label option. Toggle the Delete Timing Layer on button ON so the
previous timing map will be erased when you display another timing run. Click OK. The timing map will be
displayed for the first year. Click the Enter button to display the second year.

If you examine the timing map, you will see that continuous miner unit 1 finishes long before the other continuous
miner unit and the start of Longwall1 could be delayed. To balance the work load between the continuous miners and
to insure the longwall development is done as soon as possible, reassign the mining areas. Select the Edit Machine
Sequence w/Draw option from the Simulate pulldown menu. To make changes, use the Paste to Buffer and Paste
from Buffer options. Assign the mining areas in the following sequences.

Continuous miner 1.

subdivision 1 of the Mains. D1-1
subdivision 1 of Gate1. D2-1
subdivision 2 of the Mains. D1-2
subdivision 1 of Gate2. D4-1
subdivision 2 of Gate2.. D4-2
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Startup room 2. D5
subdivision 4 of the mains D1-4
Gate 4. D8

Continuous miner 2.

subdivision 2 of Gate 1 D2-1
Startup Room 1 D3
subdivision 3 of the Mains D1-3
Subdivision 1 of Gate 3 D6-1
Subdivision 2 of Gate 3 D6-2
Startup Room 3 D7

Place the areas in the buffer in the order specified above. Start with Continuous miner 2. Highlight the line for D4-2
and click Move to Buffer. The line for D4-2 will disappear and the following line for D5 will be highlighted. Click
Move to Buffer again and then click Previous to go to Continuous miner 1. Highlight the line where you want the
areas in the buffer to be inserted, in this case the line for D1-3 and click the Paste from Buffer button. Now
highlight D1-3 and paste it to the buffer. Repeat the process for D6-1 . Then click Next, highlight the line for D6-2
and click Paste from Buffer. The precedence specified between D2-2 and D2-1 will not affect the timing , but you
can eliminate it by highlighting the line for D2-2, erase D2-1 from the edit box and click the Change button.
Eliminate other unnecessary precedences and then click the OK button and select Save to save the changes.

Now rerun the Calculate Timing and View Timing options. The timing map should look like the following figure.
The continuous miners are about equally loaded and the longwalls are not waiting for any development work.

Output is also available in the form of production reports and a machine rebuild/replace schedule. See the manual for
procedures to generate these documents and to use the more advanced features not covered by this tutorial.


